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Notice
This manual applies to CCUBOSS 8301 Software Programming package
version 1.0, and to Security System 8300 hardware and firmware
versions 1.0. In addition, the manual and CCUBOSS may apply equally
well to future versions, although this is not guaranteed. If in the future,
compatibility restrictions are placed upon this product, a new version
and compatibility information will be made available.

Package Contents
Model 8301, the security system Software Package, contains these
items: 1) This manual, 2) The Direct Connect cabie, 3) & 4) The
CCUBQOSS program provided on both a 5-1/4" disk and a 3-1/2" disk for
compatibility with either type of disk drive.
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INTRODUCTION

CCUBOSS is a computer program that lets you

program a CCU much more easily and rapidly

than using the Display keypad (manual entry)

method. In addition, this method gives you

other increased capabilities. You can:

1. Store the programming information for rapid
retrieval or reprogramming of the system.

2. Print out the information for review.

3. Re-use and modify the set-up for similar
installations.

4. Change system programming via phone
without having to travel to the site.

With CCUBOSS, the computer can help you
through the task and allow you to select only
the things you want to do or change. The
computer screen and keyboard are easier to
use than the keypad's; you can get and give
more information more easily.

And, since you can store the data for each
installation on a computer's disk, you can
always have that information available for:
reprogramming the CCU or a replacement CCU;
checking on the original programming (at the
office instead of on-site); consulting or re-use
with minor modifications on another application.

If you have a parallel printer, CCUBOSS will
print out the system data, so that you can have
printed system information for the Monitoring
Service, your files, or phone consultation.

The program allows direct phone contact to the
CCU if you have a 300 baud Hayes-compatible
modem with your computer. This could let you
perform many operations from the office. You
could: get the event history, change an entry
delay, modify system programming as needed,
and perform other system operations without
the time and expense of a trip to the premises.
If anything requiring a call-out to the Service
occurs while CCUBOSS is connected to the
CCU, the system will disengage in an orderly
manner so that the CCU can report to the
monitoring service.

COMPUTER REQUIREMENTS

CCUBOSS will run on any 100% IBM™ PC-
compatible computer with at least one serial
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(COM) port, a paraliel port (if you intend to use
a printer), at least 256k of RAM, and MSDOS™
version 2.0 or higher operating system.

Not much disk space is required, although it is
best to have the program and the data files it
creates on a separate floppy or subdirectory of
the hard disk. The CCUBOSS program takes
less than 150k of space on your disk drive. In
addition to the program, a 360k disk with
CCUBOSS on it could also hold data from
about 50 different systems; a 720k disk, about
100 systems; and a 1.2M disk, 200 systems.
If your computer uses floppy disks, make sure
that you always have an extra (formatted) disk
available in case your original disk fills up.

For remote (phone) programming a 300 baud
Hayes-compatible modem is also required;
some laptop computers have such a modem
built in (1200 or 2400 baud modems will usually
go down to 300 baud).

PRINTER REQUIREMENTS

A parallel printer (connected to computer port
LPT1:) is optional, but will enable you to save
a paper copy of the system configuration or a
printout of the history buffer. The printer will
work fine if the DOS “print" command works.

CCU REQUIREMENTS

Requirements for the CCU are: 1) the AC
power must be connected, and 2) the internal
RAM saver battery must be ON. Refer to
Figure 1 as you connect the cord from the
power supply to the CCU main board and move
the RAM battery jumper (J102) from the OFF
position to the ON position. Leave the jumper
at ON to support the. RAM. AC power is not
required once the system (CCU) has been
programed, nor is battery power-- you can turn
the CCU switch to the off position, then unplug
the transformer and disconnect the 7-AmpHour
battery.

SECURITY

The programming process is designed for
maximum security. The required access
number (o gain access to the user’s system) is
held within that user's file and nowhere else.
The CCUBOSS program must be used to gain
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FIGURE 1: CONNECTIONS INSIDE THE CCU

access to the CCU. When programming via
phone, the CCU will talk to ONLY the phone
number programmed into the CCU.

Remember, however, that CCUBOSS has great
power to modify the customer's system. Even
though this system is employs an extremely
secure method, careless actions could
compromise that protection. To maintain
security at your end of the programming link:
1. Maintain the security of your (computer)
program and data disks (lock the computer if
hard disk, keep floppy disks in a safe).

2. Dont allow unauthorized duplication of the
data and program disks.

3. Restrict access to the phone line that has
your call-back phone number.

4. Use different Access Codes for different
users-- do not allow a single Access Code to
work for every user.

COMMUNICATION REQUIREMENTS
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PROGRAMMING THE SYSTEM BY PHONE
NOTE: If you plan to program a CCU over the
phone, the CCU’'s modem must already be
programmed with the call-back phone
number. Function Number 219 is used to
enter that phone number.

At the beginning of each connection, CCUBOSS
will check (and display) the version of the
firmware in the CCU. | that version is
incompatible, CCUBOSS will notify you and will
refuse to program the CCU.

For remote (telephone) connection, there are
four areas of consideration that must be fulfilied
before the computer and the CCU can establish
effective communications:

Connection Considerations

First, the CCU must be active, be connected to
the phone line, have the call-back telephone
number programmed in, and have "star-7-0"
incorporated in the call-back phone number to
turn off Call Waiting, if applicable. If the CCU
is already Direct-Connected to CCUBOSS at the
site, it will ignore attempts to connect by phone.

The phone connection at your end should not
have call waiting, and should not have any
other devices (answering machines, other
computers/modems) on the same line, since
they could interfere with communications.

Customer Considerations

Second, if there are people on the premises
with the CCU, they should be notified that
programming is going to take place; during that
time, their phone will seem "d2ad.” (Any alarm
or reportable Trouble will cause the CCU to
terminate your programming session.) If there
are not any people on the premises, the
programming can still proceed since the CCU
will answer the phone after a predetermined
number of rings (default = 15, setable by
Function Number 221).

Access Code Considerations

Third, your program (remote) access code must
match the one in the CCU, or the CCU will not
accept instructions from it. The factory default
is "999999" the same as the manual Access
Code. You can change the code (manually or
with CCUBOSS) using Fn#112. If you change
the code while programming, that code will be
stored with the data file and will be used the
next time you access that customer. If you do
not know the code, you can use the (keypad)
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Master Installer Local Code (Fn#111) at the
site, and could then install a new Remote Code.

Patience

Finally you need to be aware that the process
of making contact may normally be expected to
take from 15 to 120 seconds to complete, since
it entails the following steps. Your computer
calls the CCU's phone number, waits for an
answer, and identifies itself to the CCU. The
CCU seizes the phone line, hangs up, and then
calls back to your computer. Finally the two
devices establish communication and compare
Remote Access Numbers. Then the computer
screen notifies you that communication has
been established. Do not be impatient.

DIRECT (ON SITE) PROGRAMMING

For direct communications, the only physical
requirement is connecting the interconnect cable
(provided) properly between the CCU and your
computer's COM1: or COM2: (serial) port, as
shown in Figure 1. Both plugs on the cable
are shaped to fit only one way, do not force
them to fit another way.

The same Access Code is required as for
Phone programming. NOTE: Do not attempt to
perform on site programming while someone
else is doing remote programming; CCU will
ignore the phone while being direct-
programmed.

At the beginning of each connection, CCUBOSS
will check the version of the firmware in the
CCu. if that wversion is incompatible,
CCUBOSS will notify you and will refuse to
program the CCU.

INSTALLING CCUBOSS

This manual assumes that you can perform
simple computer operations like booting up the
computer and changing from one drive or sub-
directory to another. If you cannot do these
operations, seek help from an associate.

Prepare the computer for CCUBOSS in one of
the three following ways. 1) For computers with
a hard drive, make a subdirectory for
CCUBOSS ("MD C:\CCUBOSS"); 2) for an
office computer that uses floppies only, format
and label a floppy disk ("FORMAT A:"); 3) for
a floppy-disk only laptop computer that may
travel to the installation site, format the disk
with the "/s" command to install the operating
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system on the disk ("FORMAT A:/S").

After the disk is prepared, copy the CCUBOSS
master disk to the subdirectory or floppy disk
(to copy from drive "A:" to the "CCUBOSS"
directory of drive "C:", the command would be
"COPY A:*.* C:\CCUBOSS" ). Protect the data
files (those with the ".PCF" on their name) that
we provide, so that they will not have
information accidentally written over them; use
the command "ATTRIB +R" (if the files were
copied to the subdirectory "CCUBOSS" on drive
C:, the whole command would be:
ATTRIB +R C:\CCUBOSS\*.PCF

then store the original disk somewhere safe in
case your copy is damaged. There are no
special setup requirements. When you actually
start to use the program however, you may
wish to set screen colors (if using a color
monitor) by selecting "Options."

These files should be present:

CCUBOSS.EXE UL_COMM.PCF
UL1023.PCF UL1637.PCF
UL985.PCF INIT.PCF
OPERATION

COMPUTER CONNECTIONS

The computer can communicate with the CCU
in either of two ways. On-site, a cable is used
for "direct” connection between the computer’s
serial port and the CCU connection plug (See
Figure 1). From a remote location, a 300-baud
computer modem is used to call the CCU via
telephone line. The program supports using the
modem on Serial port COM1: or COM2:.

NOTE: Remember the phone/modem operation
requirements (page 2).

SPECIAL DATA FILES

It is valuable for you to have a "built in" file that
the program can read in order to set a system
to a particular requirement (such as the UL
commercial burglary Listing). A group of setup
files were provided on your disk to let you
configure your system in accordance with the
UL Listings which apply for this system.

These files have been protected so that you
cannot change or erase them. To use such a
file, you will load that file and install the correct
phone number and access codes. You can
send (Program) this information to the CCU and
you can save this information by giving it
another name-- but you cannot save it using its
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original name, since you have changed it by
adding phone numbers and access codes.
This process protects the original files so that
you do not have to worry about having them
become invalid for the UL Listing. The system
default is already in memory when the program
is loaded. If no UL files are loaded, then the
system default is used. If a UL file is used,
you can still load a Default file after, for
configuring another system.

These are the available files you can use.

UL1023.PCF
Residential Burglary UL1023.
UL985.PCF
Residential Fire, UL985.
UL1637.PCF
Residential Medical, UL 1637.
CU_COM.PCF
Commercial Burglary, combining UL365,
uULe09, UL1610, and UL1635.
INIT.PCF
Initialization (default) settings. Use this if
you need to return CCUBOSS to its initial
status (after having loaded or modified a
file).

If you have an application that includes more
than one requirement, choose one file, then

CCUBOSS, Ver 1.0,
Edit Direct Remote History Options Quit
Save File To Disk, load File From Disk, or Sen

adjust the other settings as required in the UL
requirements or as noted in the Installer's
Manual.

STARTING THE PROGRAM
Change to the drive, or the subdirectory,
containing the CCUBOSS files.

To start, type the name and press the <RET>
or <ENTER> key.
CCUBOSS <RET>

USING CCUBOSS

The program is "menu driven,” meaning that
you operate it by selecting from the lists of
options shown on the screen. CCUBOSS will
completely program the Communications Control
Unit (CCU) for the installation (except that the
CCU must be previously programmed with the
modem callback number (Fn#219), if you are
going to program by telephone.

Figure 2 shows the main menu screen. The
first line on the screen has a list of the
available options, with one of them highlighted.
The second line has an explanation of that
highlighted option.

Selecting Options & Moving Through Menus
CCUBOSS uses the common methods of
selecting from the menu line. (1) You can

(c) AT&T 1991 2:44:58 PM 7]

ile To Printer.

Explanation of Highlighted
Menu ltem

Menu To Select From

Figure 2: MAIN SCREEN MENU
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move the highlighting to the option you desire

(using the space bar or arrow keys), and make
the actual selection by pressing the [RETURN]
or [ENTER] key. (2) You can directly select an
option from the menu line by pressing a letter
key (the first letter of that option you wish to
pick, this letter is shown in the "Help Text" color
on color screens). In Figure 2 the "File" option
is highlighted. You can select it by pressing
[ENTER]; you could have just pressed [F] for
"file” even if another option were highlighted.

Go ahead and move from one menu to another
to get a feel for how the operation works; no
damage will occur. If you try to use the Direct
Connect or Remote Connect menus without
being connected to a CCU, nothing disastrous
will happen-- the program will simply tell you
that you cannot use that option. No damage
will occur due to your “looking through"
CCUBOSS.

Working "Inside” a Menu Screen
A good place to begin might be the "Options"
menu (Figure 3).

CCUBOQSS, Ver 1.0,
Edit
Set Color For Borders

(c) AT&T 1991

To get "into" a menu screen and make choices,
you must press [ENTER] while "edit" is
highlighted on the top line; this moves the high-
lighting into the center of the screen where the
programming items are located. Use the
up/down arrows, or [ENTER] to move through
the different items.

Some items require that you type in numbers or
characters to make your choice. Other items
will not let you enter numbers or letters; these
are “"toggles.” For the toggles, you press the
space bar and the item choice changes through
a small number of options. (For example, the
"Sound" item toggles between On and Off, the
"Port" item toggles between COM1: and
COM2:) NOTE: the "Guide"line at the bottom
of the screen will tell what you can enter.

To accept a choice, either use the up/down
arrows or the [ENTER] key (do not use the
[ESC] key) to go to the next choice-- it will not
enter the choice).

Use the [ESC] key to move "backwards" out of
the current menu towards the main menu.

2:44:58 PM 7]
ol
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2
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Modem Sound: ON

/HELP TEXT

7

J

Allowable Values Are 0 - 7

Press Esc To Return

Text Color: 7 Border Color:

Help Text Color: 2K/TEXT Background Color: O
Highlight Foreground: SJ Highlight Background: 1
Sound: OFF_ / Serial Port: COM1

Kl EN

Dialing Method: Puls

Highlight
Background

3

Colorf

To Previous—/———

Highlight

Foreground

FIGURE 3: OPTIONS SCREEN MENU
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MENU OPTIONS

This part of the manual discusses the screens
(menus) you will use during your programming
of the system. The previous section on Using
CCUBOSS talked about how to move, make
choices, and back out of the program. If you
have not read that part of the manual, you
should do that now.

MAIN

After you have started CCUBOSS, as instructed
in the previous section, the Main menu is the
first one you see. From it you can select:

File Menu

Edit Options

Direct Connect

Remote Connect

History Menu

Options Menu

Quit Menu
The following information is organized as you
might use the different menus and operations,
and discusses the menus’ capabilities in some
depth.  After gaining understanding of the
different menus’ functions, use the Programming
Tree (Figure 4) to help you master the task of
"traveling" between the menus.

OPTIONS

The Options menu (see Figure 3) lets you
select which colors, sounds, and the COM port
for your modem-- it is also a good place to get
the "feel" of the program. Select colors which
are easy to see, or select black and white for
your monochrome screen. (If you select colors
that make it impossible to see the text, you can
always turn the computer off-- the program will
never stat up in an unviewable color
configuration.) Also on this screen are the
computer-Sound on/off option; the Port option,
which allows you to tell the program where
(COM1: or COM2:) to find the modem/phone
connection; and Touch-Tone/Pulse dialing
selection.

The numbers in the mid-screen box show the
color (in background) that corresponds to each
number. Use these for guidance in your color
choices. For black and white screens, you can
choose 0 (black) and 7 (white); it will be most
useful to have Text Color = 7 and
Background Color = 0 then have Highlight
Foreground = 0 and Highlight Background =
7. If your experimenting makes parts of the
screen disappear, turn the system off and re-
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boot-- the CCUBOSS will disaliow color
combinations that won't work.

The Text Color choice refers mostly to the
items you will change. It also determines the
color of the Time, shown in the upper right.

Border Color is the color for the box lines.

Help Text Color is for the rest of the
messages, everything the program provides.

Background Color allows you to assign a color
to the background (the rest of the screen).

Highlight Foreground is the color for the
highlighted item (the one you are currently
programming).

Sound beeps can be toggled off if they are
irritating to you.

Serial Port refers to your selection for the
output (direct connect or modem/phone), and
toggles between COM1: and COM2..

Modem Sound turns on and off the speaker (if
available) on your modem. This will allow you
to hear the dial tone, modem dialing, and the
answering at the other end. This might be of
value in verifying that the dialing proceeded
correctly. After the CCU answers at the other
end, the speaker turns off.

Dialing Method allows you to select either
pulse or touchtone, depending upon what is
supported by your phone line.

FILE (Save, Load, Print)

A data file (one which ends in .PCF) for a
system will contain the information for every
Function Number listed in the Installer's Manual,
the contents of the 64-event history buffer (if
loaded from the CCU), and the phone number
to call to reach the CCU. Each data file is
stored temporarily in the computer's memory,
and will be lost if the computer is turned off or
used for something else.

Each data file can be stored more permanently
on a disk with the Save function. When you
decide to save a file, the program will ask you
for a name (use up to eight letters and
numbers, plus the dash if you wish, the
program will automatically add the .PCF); you
may choose to use part of the customer's name
plus the number you assign for billing.
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NOTE: This file takes a relatively small amount
of space, but your disk may eventually become
full, since there will be one for each customer.
If your disk becomes full of data files, the
program will tell you; you can then take out the
disk in the drive and replace it with a
(formatted) disk that has enough free space to
save onto. (If you have more than one drive
and understand DOS, you can save to the other
drive by adding the drive name to the filename
when saving-- "Bfilename".)

You can also Load a file of data back into the

computer from the disk. After doing this, you
could modify the data slightly and use it for
another (different) installation, then save it again
with a new name.

In addition, this menu will let you Print the data
ift you have a printer connected to your
computer. This will allow you to have a com-
plete record to keep in the customers file
folder, if you wish.

The screen will show those files you already
have in the current directory, to help you in
your Save, Load, or Print selection.

EDIT

The Edit menu does not connect you to a
Security System. It does allow you to See and
Edit (revise) the entire Security System 8300
configuration that is currently in the computer’s
memory. This configuration is the default
system setting, unless you have already used
the FILE or DIRECT/REMOTE menus to load a
different configuration into memory from a disk
or existing system, or unless you have already
made some changes with this EDIT function.

The numbers on the Help line correspond to
groups of the Function Numbers in the Pro-
gramming portion (Sec. lll) of the Installer's
manual. Refer to that manual for complete
discussions of the different Function Numbers.

You can select "Edit" (see "Selecting Options &
Moving Through the Menu," p 4), then select
from the numbers to View the settings for that
series of Function Numbers. You can also
change (Edit) the setup; after viewing a set of
Function Numbers you can select EDIT (again)
to move into the displayed settings. From there
you can change settings as discussed in
"Working Inside a Menu Screen," page 5.

DIRECT CONNECT/REMOTE CONNECT (File,

Software Package Model 8301 page 7

Edit, Program, Read, History, SetClock,
GetClock, Arm, Disconnect)

The Main menu options of Direct and Remote
are the only options that give communication
between your PC and the system’'s CCU. You
can send a setup to the CCU, read the CCU's
current setup into the PC, or use the PC to do
many of the things that, otherwise, you would
have to do on site with a full text keypad.

Before selecting either of these functions, make
sure that you have met the computer and
communications requirements (pages 1&2).

Select "Direct” if you are on-site and connected
to the CCU by the cable provided; select
"Remote" to contact the CCU by telephone.

NOTE: Load ("Read") the customer's data file
from disk first. It has their phone number and
the access code. On the first call to a new
customer, program the access code (Fn#112)
before calling; you will be prompted for the
phone number.

NOTE: After connecting to a customer (except
for the first connection), read the complete
data from the CCU first, In case the system
has beenh changed since your last contact
(Fn#712 can be changed by the user, bypasses
could have been entered, other changes could
be made on-site by service personnel and not
get into the disk file); if you do not do this,
the CCU’s Trouble and Bypass information
will be erased.

These are the functions available under the
Direct/Remote connect part of tne menu:

Normally, Read should be the first function you
perform (see the preceding note). It loads a
copy of the current installation configuration into
the computer for you to see and change as
needed. The bottom panel of your computer
screen shows what is being "read.”

Edit allows you to make changes in what has
been loaded into memory, but does not
automatically send this back to the security
system. Use Edit the same way as EDIT in
the main menu.

Program sends the revised configuration back to
the system. The bottom panel of your screen
shows what is being sent back to the system.

History let you Read the history buffer from the
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security system-- but it does not go ahead and
read the history buffer automatically; you must
select Read after selecting History. If you do
initially see a history display, it is "old" data
from the users file on the computer disk).

NOTE: If you arm the system using CCUBOSS
(not for use with UL Listed systems), you must
immediately select History and then Read; this
lets you verity the arming, and see if Priority
Zones/Sensors were bypassed (shunted).
Reading the history buffer empties the data
from the security system. After "read"-ing, you
can "print" out on paper, "view" on the screen,
or "erase” the data (from your computer). If
you read the history buffer and don't "erase" it,
it will be part of the file that you save on disk.

GetClock allows you to see what the security
system's clock says. |If there is doubt about
clock accuracy or time zones to a remote
installation, use "getclock.”

SetClock will set the security system clock to
the time on your computer's clock (shown on
the upper right of the screen). To set the clock
to a different time, leave CCUBOSS and reset
your computer’s clock (DOS’s "time" command).

Arm is a powerful command that will allow you
to help customers if they need to have the
system armed/disarmed but are not on the
premises. NOTE: This option is expressly
forbidden for UL installations. Because of the
potential for lawsuit, you should establish a very
secure password procedure (perhaps including
a Duress word) to control use of this function.

NOTE: since Arming is so important, the remote
Arm command will override any sensors-- even
shunting Priority sensors if necessary. You
must check for this possibility by using the
History - Read commands. (NOTE: if Fn#320
Bypass Report Option is ON, the CCU will
seize the phone line to report the bypass to the
Monitoring Service-- the CCUBOSS connection
will be terminated, and you will have to re-
establish phone connection.) If Priority
sensors are bypassed (shunted), you may want
to go to the site, report that the system cannot
be armed, or consult further with the user.

You can toggie the selection between OFF,
DAY, NIGHT, and AWAY using the space bar,
then press [ENTER] to select the desired Level
of Protection. Remember, the display does
NOT show the current system Level of
Protection-- it shows the level you will set the
system to, if you select it with the [ENTER] key.

Software Package Model 8301 page 8

Don't confuse this function with the Shut Down,
Local, Remote mode (Fn#113).

Disconnect is the command to stop communi-
cating with the security system (use Program to
send new configuration before Disconnect-ing,
if necessary) and leave this portion of the
menu. The system configuration that you have
created in your computer's memory is still there;
you can save, view, or revise it using the other
portions of CCUBOSS.

Program allows you to send the current set-up
file (and changes you have made) to the CCU.

HISTORY (Print, View, Erase)

Like the other History, this (separate) one can
send the history (in computer memory) to the
printer or display it on the computer screen, or
it can erase the history from its memory. It
cannot "read” the CCU history -- that can only
be done under Direct or Remote. See the
preceding paragraphs.

QuIt

When you have completed all of the actions
you want to do, you will Quit. This may mean
pushing the [ESC] button one or more times, to
reach the main menu, and finally selecting Quit.
If you have modified the configuration that is
currently in memory, the program will give you
the option of saving the current configuration
(data file); you can only save a file that is not
named with one of the default names (such as
UL1023.PCF) -- if the current file name is a
default name, you will be given the opportunity
to change it.

NOTE: In the following chart is a map, with
levels of indent showing which menus are
available “under" others (for example, Save and
Load and Print belong to the File menu). To
help avoid confusion, remember that there are
3 places data can exist-- and the chart always
explains which places are involved. They are:
1) Memory-- the computer's memory; not
permanent.
2) Disk-- the computers permanent storage.
3) System 8300-- the security system; nothing
ever affects the system unless you Direct
or Remote connect and Program.
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Programming Tree
Menu Levels:
1.2 3
FILE - *move data files to & from disk storage
SAVE -- write onto disk
LOAD -- get from disk into memory
PRINT -- send to printer
EDIT -- see/change functions in memory
(111, 211, 231, 311, 411, 511,
611, 711, 731, 811, 821)
DIRECT (or)
REMOTE -- connect to a System 8300
FILE -- move data to or from disk, to printer
EDIT -- view or modify data in memory
PROGRAM -- send to System 8300
READ -- get system data from System 8300
HISTORY
Read -- get history buffer from System 8300
Print -- print what's in memory
View -- see what's in memory
Erase -- blank memory
SETCLOCK -- set System 8300 clock
GETCLOCK -- see System 8300's time setting
ARM -- set to OFF, DAY, NIGHT, AWAY
DISCONNECT -- break communications
HISTORY -- list of system’s events as stored in memory
PRINT -- print what's in memory
VIEW -- see what's in memory
ERASE -- clear memory's list
OPTIONS -- setup the program
(screen colors, sound, COM port)
QUIT -- leave CCUBOSS (use FILE to save, first)

* The text explains the operation associated with each
menu selection.
FIGURE 4: PROGRAMMING TREE

TROUBLESHOOTING PROBLEMS/SOLUTIONS

PROBLEM: | was working with CCUBOSS and
the CCU hung up on me...

SOLUTION: The system will hang up if it needs
to call the monitoring service (e.g., to repont an
alarm, trouble, bypass, etc.).

PROBLEM: It seems to take a lot longer to
transfer data via the "remote" connection
compared to the "direct.”

SOLUTION: You are right, by the nature of the
process it is possible to move data faster via
direct connection since the phone process has
to go through a modem to put the information
into your computer.

PROBLEM: | can't seem to connect by phone.
SOLUTION: Remember that you have to load
the customer’s file from disk first... it has the
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phone number and the dealer access code,
which the program needs to connect.

PROBLEM: The message says to verify the
Serial Port Assignment. What is that all about?
SOLUTION: You may be using a portable
computer with a built-in modem. At the office
you will want to use the modem (perhaps it is
on serial port COM1:); at the site you will want
to connect directly (that would be the other
serial port, perhaps COM2:). You can change
serial ports under the "Options” menu for "Port."

PROBLEM: | called a new installation to
program it, and the computer waited and
waited...

SOLUTION: First, the system has to have the
number to call back programmed in (Fn#219).
Also, if the system is being programmed locally,
it will not accept remote programming at that
time.

PROBLEM: How do | completely remove a
customer access code?

SOLUTION: Set the access code (Fn#814) to
zero.

PROBLEM: | cant seem to get the history
buffer from the CCU.

SOLUTION: Handling the history buffer is a little
complex. To get the history from the CCU and
into the CCUBOSS file, you must; a) connect to
the CCU with either the Remote or Direct
menu; b) select History in that menu, and; c)
Read the history. Then d) tell it to Save the
file. Remember that reading the history from
the CCU removes those history items from the
CCU’'s memory; it also writes these items over
the items that were previously stored in that
account’s file.

PROBLEM: When | go to History while
connected to a CCU, | sometimes see a history
listing without even having to Read...
SOLUTION: What you see is the "old” history
that was in the file from the time before.
Notice that the dates are old. When you Read,
the "old" history will be replaced.

PROBLEM: How can | keep all of the history?
SOLUTION: Do that by sending each history file
to the printer as soon as you get it from the
CCU. The printed copy will be your permanent
record.
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PROBLEM: How can | get the file (with the
default settings) back into the computer? I'm
starting a "new" installation and don‘t want the
file | was working on anymore.

SOLUTION: When you installed CCUBOSS, we
told you to use ATTRIB to protect the files you
had. If you did, you have a file called
INIT.PCF, which is exactly what you want.
Read it into memory from your disk, and you're
ready to go.

PROBLEM: One of my ".PCF" files has
changed! You said they would always stay the
same.

SOLUTION: If the files were "treated" with the
ATTRIB command as shown in page 3, they
should be impossible to change. To restore
them now, copy them over again from the
original disk. Then use ATTRIB (page 3) to
make sure they don't get changed.

PROBLEM: | get a message saying something
like, "error, can't write to file"

SOLUTION: You may be trying to save a
"default” file without remembering to change the
name. Default files are the ones we provided
on the disk; during installation we instructed you
to use the ATTRIB command to protect the
" PCF" files against being changed.

PROBLEM: It says my disk is full. What do |
do now?

SOLUTION: Dont panic. You should have
another (formatted) disk available. You can
remove the current disk without any effect on
the program, and replace it with the other.
Then select the save option again, and things
should go smoothly. In a pinch almost any disk
you use with that computer could be okay-- it
will only have to hold about 5k of data (less
than 2% of any disk’s capacity) for one file. If
you know enough about DOS, you can redirect
the file to another drive by adding the path to
the filename for saving. Also, see the problem
which follows.

PROBLEM: I've got so much stuff on my disk
that there isn't much space left. And all of
those files are a bit confusing.

SOLUTION: With the DOS commands (while
not in CCUBOSS), you can copy them to
another disk for safekeeping, and you can
erase them from your disk.

Use COPY to make another copy on a
different disk for safekeeping. Select the names
of the files you want to move. Exit CCUBOSS.
Refer to your DOS manual and copy the files
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to the disk where you want them. After copying
the files, you can use DELETE to erase them
from your disk.

PROBLEM: My CCUBOSS disk stopped
working.

SOLUTION: The 5-1/4 inch floppy disks can be
damaged or erased by accident; the 3-1/4 inch
disks are usually pretty safe. Here are potential
“data destroyers:”

- Dirt, smoke, hair, fingerprints, etc. Even
a particle of cigarette smoke on a disk can
damage both the disk, and your computer’s disk
drive.

- Bending. A crease in the disk will mean
that that area cannot be read.

- Static Electricity. If a spark jumps from
your fingertip to the disk, part of the disk is
probably erased. It is possible that most data
can be recovered by a computer hacker with
the right utility programs.

- Magnetism. Refrigerator magnets, motors,
telephone ringers, and other sources of magnet-
ism may erase all or part of your disk. As with
static electricity, it may be possible to reclaim
some of the data.

You can re-install on a new disk from the
master disk that you saved for this purpose. It
is quite possible that a knowledgeable computer
person or shop can save your ".PCF" files from
the disk.
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Instruction Sheet

AT&T Security System 8300 Configuration Software Update Version Beta 1.5 for
AT&T CCUBOSS Model 8301 Configuration Software Package Version 1.0

This packet contains information and new Software to update the AT& T Security System 8300
Configuration Software Model 8301 Version 1.0

Package contains these items: 1) Instruction sheet Issue 1.0, 2) CCUBOSS software Version
Beta 1.5 on 3-1/2” disk.

This Instruction Sheet is intended to be used with AT&T Security System 8300 Software Package
Manual Issue 1.1.

INSTALLING CCUBOSS VERSION BETA 1.5
See AT&T Security System 8300 Software Package Manual Issue 1.1 page 3 INSTALLING CCUBOSS.
Note: When installation is complete the old version will be replaced with Version Beta 1.5.

STARTING PROGRAM VERSION BETA 1.5 .
See AT&T Security System 8300 Software Package Manual Issue 1.1 page 4 STARTING THE PROGRAM.

MAIN OPTIONS

See AT&T Security System 8300 Software Package Manual Issue 1.1 page 6 MAIN.
*File Menu Changed in Version Beta 1.5
*Option Menu Changed in Version Beta 1.5

rILE (Directory, Save, Load, Erase, Print, Quit)

See AT&T Security System 8300 Software Package Manual Issue 1.1 page 6 FILE.
*Directory This option lets you select the disk drive and directory where user files are to be stored.
*Erase This option lets you erase a file from the disk.
*Quit This exits the CCUBOSS program.

OPTIONS
See AT&T Security System 8300 Software Package Manual Issue 1.1 page 6 OPTIONS.
*Modem Setup If your modem needs additional initialization put the AT command here.
Note: 1. For remote (phone) Programming a 300 baud Hayes-compatible modem is required.
2. If nothing is entered on the Modem Setup line the CCUBOSS will work like Version 1.0.
3. Consult your modem manual for the proper commands to set your modem to 300 baud.
4. Some new modems will not will work at 300 baud in these cases a different modem will
be required.
5. If you are not sure if your modem will work at 300 baud most modem manufactures
have a customer support hotline. They should be contacted and asked, what commands are
necessary to return the modem to 300 baud.
6. If you are buying a new modem always ask, is the modem capable of running at Hayes-compatible
300 baud.
Example: Practical Peripheral Modem 2400SA V.42 bis
Modem Setup: AT B16 S37=3

AT - Required command prefix, B16 - Initiate call using Bell 103 at 300 bps, $37=3 - 300 bps
communication

* = New and improved changes in Beta Version 1.5



